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In this Recipe, you will learn how to create an animated movie using VideoBlender. You
will import a folder of images, add a title, credits, text effects, audio, shapes, and
transitions, and then export the animation as a movie. 
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Introduction

Open VideoBlender. 

Click the Start button, choose All Programs, choose Tech4Learning, choose
VideoBlender, and select VideoBlender. 

VideoBlender will open. 
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Add a Folder of Images

When VideoBlender opens, you will see an empty animation. You need to add frames
to the animation to begin. 

Click the Frame button on the toolbar. 

You will see a list of options. 

Click From a Folder. 

You will see the Please select a folder dialog. 
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Click the My Computer button on the left. 
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This tutorial will use the sample images that come with VideoBlender. 

Double-click Local Disk (C). 

Double-click the Program Files folder. 

Double-click the Tech4Learning folder. 

Double-click the VideoBlender folder. 

Double-click the Media folder. 

Double-click the Clay Animation folder. 

Click the Seasons folder. 
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Click the Open button. 

You will see the images being processed. 
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You will see all of the images in the Frame List. 

The images are added in alpha-numeric order based on the name of the image file. 

You will see the first frame in the preview area. 

Page 8 of 50Create an Animated Movie
VideoBlender 2

Recipes4Success www.tech4learning.com ©  2004 Tech4Learning, Inc.



Preview the Animation

You can preview the animation. 

Click the Play Animation button below the preview. 

You will see a preview of the animation. 
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The preview will end at the last frame of the animation. 

Save the Animation

You should save the animation as you work on it. 

Go to the File menu and choose Save Animation. 

You will see the Save dialog. 
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Type a name for the animation in the File name field. 

Use the Save in pull-down menu to choose a place to save the animation. 

Click the Save button. 

The animation will be saved.

Page 11 of 50Create an Animated Movie
VideoBlender 2

Recipes4Success www.tech4learning.com ©  2004 Tech4Learning, Inc.



Add a New Frame

You can add more frames to an animation. You will add a blank frame to use as a title
for the animation. 

Click the Frame button on the toolbar. 

You will see a new frame added to the end of the Frame List. 
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You will also see a black frame in the preview area.

Change the Order of Frames

You can change the order of frames in an animation. 

Click and drag the new frame toward the top of the Frame List. 

You will see the Frame List scroll toward the top as you drag. 

Release the mouse button when you see a black line above the first frame in the Frame
List. 

The blank frame is now the first frame in the animation. 
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Change the Background Color

You can change the background color of a frame. 

Click the first frame in the Frame List. 

The Editing Panel will display the frame editing tools. 

You will see a color palette. 

Click a new color on the palette. 

The frame will change to show this new background color. 
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Add a Text Object

You can add text to create a title for the animation. 

Click the Text button on the toolbar. 

You will see a text object in the upper left corner of the frame. 
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Click and drag the text object to the middle of the frame. 
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Double-click the text object. 

You will see a blinking cursor in the text object. 

Click and drag the cursor to select all of the text. 
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Type: Changing Seasons 

Click the frame outside of the text object when you are done. 

The text object will no longer be selected. 

Format Text

You can change the way text looks. 

Click the text object to select it again. 

You will see the text editing tools in the Editing Panel. 
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Click the Font pull-down menu and choose a new font. 

The new font may not fit well in the text object. 

You can resize the text object. 

There are handles around the edge of the text object. 

Click and drag a handle away from the center of the object to make the object larger. 
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Click and drag the text object to re-center it in the frame. 

Click and drag the Size slider on the Editing Panel to the right to make the font larger. 

The preview will change as you drag the slider. 

Click the Color swatch to choose a new text color. 
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You will see a color palette. 

Click a new color on the palette. 

The text will change to the new color. 

Click and drag the text object to center it in the frame. 
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Click the frame outside of the text object when you are done. 
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Change Frame Duration

You can change the length of time a frame is shown. The title frame should last longer
than other frames in the animation. 

You will see the frame editing tools in the Editing Panel. 

Click and drag the Duration slider to the right to make the frame show for 3 seconds.
This will give viewers time to read the title. 
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Add Another Frame

You can add another frame at the end of the animation for closing credits. 

Click the last frame in the Frame List. 

Click the Frame button on the toolbar and choose New Blank Frame. 
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You will see a new frame added to the end of the Frame List. 

The frame will show in the preview area. 

Use the skills you have learned to change the background color. 

Use the Duration slide to set the frame to show for 5 seconds. 
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Add a Text Object

Click the Text button on the toolbar. 

You will see a text object in the upper left corner of the frame. 
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Use the skills you have learned to add and format text for closing credits for your
animation. 
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Add a Text Effect

You can add effects to your text. 

Click the Text Effect button on the toolbar. 

You will see the text effect options in the Editing Panel. 
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Click the type of text effect you want for the text. 

Use the Options pull-down menu to choose the options for the effect. This is usually a
direction. 

Use the Time slider to choose how long you want the effect to take. You can see a
preview on the right. 

Click the Add button when you are done. 

VideoBlender will render the frames needed for the text effect.

Page 29 of 50Create an Animated Movie
VideoBlender 2

Recipes4Success www.tech4learning.com ©  2004 Tech4Learning, Inc.



Add a Transition

You can add transitions between frames in an animation. Transitions are added before
the selected frame. 

Click the second frame in the Frame List to add a transition between frames one and
two. 

Click the Transition button on the toolbar. 

You will see the transition tools in the Editing Panel. 

Select a transition from the Transition Types lists. 
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You will see a preview of the transition in the preview on the Editing Panel. 

Some transitions have options. 

If the transition you chose has options, the Options pull-down menu will become active. 

Select a direction for the transition. 

Click and drag the Time slider to the right to make the transition last longer. 
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When you have chosen a transition, click the Add button. 

You will see the transition frames being processed. 

After the transition has been created, you will see the transition in the Frame List. 

Use the skills you have learned to add another transition between the last image in the
animation and the closing credits frame. 
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Add Audio

You can add a soundtrack to the animation. 

Click the first frame in the animation. 

Click the Audio button on the toolbar. 

Choose From File. 

You will see the Open File dialog. 
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Click the My Computer button on the left. 

Double-click Local Disk (C). 

Double-click the Program Files folder. 

Double-click the Tech4Learning folder. 

Double-click the VideoBlender folder. 

Double-click the Media folder. 

Double-click the Clay Animation folder. 

Click Seasons.wav to select it. 
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Click the Open button. 

You will see the audio track added to the top sound track in the Timeline. 

Click the Rewind Animation button in the preview area. 
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You will see the first frame of the movie. 

Click the Play Animation button to preview the animation. 

You will see the animation and hear the soundtrack. 

Click the Save button on the toolbar. 

Add a Shape

You can add a shape to a scene. A circle can make a great thought bubble. 

Click the frame titled Clay-010 Frame in the Frame List. 

You will see this frame in the preview area on the right. 
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Click the Shape button on the toolbar. 

Click Add Circle from the list. 
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You will see a circle in the upper left corner of the frame. 
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To resize the circle, click and drag a corner handle. Make the circle larger and oval
shaped. 

Click and drag the oval to position it on the frame. 

Page 39 of 50Create an Animated Movie
VideoBlender 2

Recipes4Success www.tech4learning.com ©  2004 Tech4Learning, Inc.



You will see the shape editing tools in the Editing Panel. 

Click the Fill Color button and choose a dark color to fill the thought bubble. 
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You will see the fill color change in the preview area. 

Add a Caption

You can add text and place it over the thought bubble. 

Click the Text button on the toolbar. 

You will see a text object in the upper left corner of the frame. 
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Click and drag the text object over the oval shape. 

Position the cursor over one of the sizing handles. 

Click and drag to make the text object as large as the oval shape. 

Click and drag to position the text object directly over the oval shape.
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Double-click the text object. 

You will see a blinking cursor. 

Delete the text in the object. 

Type new text. 

Since this frame has text, you will want it to show for a longer time so that the viewer
can read the text. 

The Editing Panel shows the text editing tools. To change the timing, you need to see
the frame editing tools. 

Click the Clay-010 Frame in the Frame List. 
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You will see the frame editing tools in the Editing Panel. 

Click and drag the Duration slider to the right to show the frame for 3 seconds. 

Make a Movie

You can export the animation as a movie file you can share with other people. 

Click the Make button on the toolbar. 

You will see the Export Animation dialog. 
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Click AVI in the File Type list. 

This will create an AVI movie. 
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Click the Export button. 

You will see the Save dialog. 
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Type a name for the movie in the File name field. 

Choose a place to save the movie. 

Click the Save button. 

You will see the AVI Settings dialog. 

VideoBlender will create the movie. 
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View the Movie

Once the movie has been exported, go to the File menu and choose Exit. 

VideoBlender will close. 

Navigate to the place where you saved the movie. 

Double-click the movie file to open it. 

Click the Play button to watch the movie.
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You will see you clay animation movie! 

When you are finished watching the movie, click the Close button in the upper right
corner of the window.

Conclusion

Congratulations! You have created an animated movie using VideoBlender. 

In this Recipe, you learned how to: 

Open VideoBlender 
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Add a folder of images 

Preview an animation 

Save an animation 

Add a blank frame 

Change the order of frames 

Add text 

Format text 

Add text effects 

Add transitions 

Add audio 

Add a shape 

Make a movie
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